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Laboration 1

Kapitel 1-2: Kurshemsidan, hederskodex, incheckning, IDLE, print-satsen, kom-
mentarer, variabler, strängar, beräkningar, indata

Denna labb redovisas skriftligt, med svar på instuderingsuppgifterna. Glöm
inte att skriva namn och PBL-gruppsnummer på det du lämnar in!

Inloggning

Slå dig ned vid en ledig dator tillsammans med en jämnbra labbkompis. Ni bör
båda ha kvitterat ut var sitt användarkonto (användarnamn och tillhörande
lösenord). Välj ett av kontona och logga in.

Webbläsare och kurshemsidan

Med en webbläsare som t ex Internet Explorer kan du utforska Internet där
bland annat kurshemsidan finns. Den webbläsaren kan startas genom att från
startmenyn välja Internet Explorer. Starta webbläsaren och skriv in adressen

http://www.csc.kth.se/2D1311/

samt tryck på returtangenten. På hemsidan finns massor av nyttig informa-
tion, och du gör klokt i att alltid ha en webbläsare igång och kurshemsidan
lättillgänglig när du labbar.

För att slippa skriva in den långa adressen varje gång du ska titta på kurs-
hemsidan bör du spara ett bokmärke (Favorite).

Hederskodex

På Nada används en gemensam hederskodex för alla Nadakurser. Du hittar den
via kurshemsidan och är själv ansvarig att läsa igenom och följa den.

Vilka är de fem reglerna i hederskodexen?

Incheckning kursen

På kurshemsidan finns information om incheckning. Se till att båda blir in-
checkade. Var noggrann med alla personuppgifter! Fråga din assistent vilken
PBL-grupp ni tillhör.

Gemensam labbkatalog

Vill ni skapa en gemensam katalog (som bägge gruppmedlemmarna har tillgång
till) för labbfilerna? Bläddra isåfall till sidan 8 i detta labbhäfte!
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Starta IDLE

Välj Start → Programs → Python → IDLE från startmenyn. Fönstret Python
Shell som öppnas är en Python-interpretator, där man direkt kan skriva in en
sats och se vad som händer.

Längst upp i fönstret kan man välja bland menyerna File, Edit, Windows
och Help. Välj File →New Window så öppnas ett nytt fönster där man kan
skriva in, redigera, spara, och köra Python-program.

För att spara det program du skrivit in väljer du File →Save As. Ge alltid
dina program suffixet .py (t ex Gorn.py).

När du är redo att provköra programmet väljer du Edit →Run Script.
Utmatningen från programmet kommer att synas i Python Shell-fönstret.

Gör följande

En valfri utmaning från kapitel ett samt utmaning 1 och 3 från kapitel två.

Instuderingsfrågor

1. Vilka programmeringsspråk känner du till?

2. Hur skriver man en kommentar i Python?

3. Varför är kommentarer viktiga?

4. Vad är IDLE?

5. Hur får man programmet att skriva ut text på skärmen?

6. Ge exempel på två olika datatyper.

7. Vad är en variabel?

8. Hur ger man en variabel ett värde?

9. Hur läser man in ett ord till programmet?

10. Hur läser man in ett tal till programmet?

11. Vad är det för vits med att låta programmet läsa in värden?

12. Hur får man programmet att skriva ut ett variabelvärde på skärmen?
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Laboration 2

Kapitel 3-4: Slumptal, if-satsen, while-slingan, programplanering, for-slingan,
strängar, tupler

Vid redovisningen ska du kunna förklara både program och svaren till frå-
gorna för dina kurskamrater med hjälp av en skrivtavla.

Gör följande

Minst en valfri utmaning från kapitel tre samt en från kapitel fyra.

Instuderingsfrågor

1. Hur slumpar man ett tal i ett Pythonprogram?

2. Vad gör raden import random

3. Vad är det för skillnad på if-satsen och while-slingan?

4. Ge ett exempel på ett villkor. Vilka värden kan ett villkor anta?

5. Ge exempel på ett program

6. Vad är en algoritm?

7. När använder man en for-slinga istället för en while-slinga?

8. Hur skriver man ut första bokstaven i en sträng?

9. Hur ändrar man första bokstaven i en sträng?

10. Ge exempel på en strängskivning (slice).

11. Vad kan man använda tupler till?

12. Hur skriver man ut en tuppel?
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Laboration 3

Kapitel 5-6: Listor, uppslagslistor, funktioner, parametrar, namnrymden.
Vid redovisningen ska du kunna förklara både program och svaren till frå-

gorna för dina kurskamrater med hjälp av en skrivtavla.

Gör följande

Utmaning 2 från kapitel fem samt minst en valfri från kapitel 6.

Instuderingsfrågor

1. Vad är det för skillnad mellan en lista och en tuppel?

2. Beskriv tre metoder som finns för en lista?

3. Visa hur man skriver ut alla elementen i en nästlad lista.

4. Visa med ett exempel hur referenser fungerar.

5. Hur fungerar en ordlista (dictionary)?

6. Beskriv tre metoder som finns för en ordlista.

7. Hur definierar man en funktion?

8. Varför anropar man funktioner?

9. Vad innebär abstraktion?

10. Hur tar en funktion emot indata? Visa med ett exempel!

11. Hur skickar man utdata från en funktion? Visa med ett exempel!

12. Vad är det för skillnad mellan lokala och globala variabler?
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Laboration 4

Kapitel 7-8: Filer, särfall(exceptions), konservering (pickling), klasser, metoder,
objekt, konstruktor, attribut

Vid redovisningen ska du kunna förklara både program och svaren till frå-
gorna för dina kurskamrater med hjälp av en skrivtavla.

Gör följande

Utmaning 4 från kapitel sju samt utmaning 2 från kapitel åtta.

Instuderingsfrågor

1. I vilka moder kan man öppna en textfil?

2. Ge två olika förslag på hur man kan läsa in alla rader från en fil.

3. Varför vill man låta ett program skriva ut data på en fil?

4. Vilka typer av data kan man konservera (pickle)?

5. Hur återställer man konserverade data?

6. När används särfall (exceptions)?

7. Vad är relationen mellan klass och objekt?

8. Vad är en metod?

9. Hur fungerar en konstruktor?

10. Hur kommer man åt ett objekts attribut?

11. Vad kännetecknar klassattribut och statiska metoder?

12. Varför ska man använda metoder för att ändra ett objekts attribut?



2D1311 S1 2006-2007 7

Laboration 5

Kapitel 9: Objektorienterad programmering, arv, polymorfism, moduler Vid
redovisningen ska du kunna förklara både program och svaren till frågorna för
dina kurskamrater med hjälp av en skrivtavla.

Gör följande

Utmaning 1 från kapitel nio.

Instuderingsfrågor

1. Föreslå något som kan representeras med en klass.

2. Vilka attribut ska din klass ha?

3. Och vilka metoder?

4. Rita ett objekt (med exempeldata) som är en instans av din klass.

5. Hur går det till när ett objekt skickar ett meddelande till ett annat?

6. Föreslå ett program där objekt behöver interagera.

7. Hur strukturerar man många objekt av samma typ i sitt program?

8. Rita ett exempel på en sådan struktur.

9. Hur lägger man upp en utskrift av data från alla objekten?

10. Vad används arv (inheritance) till?

11. Ge ett exempel på polymorfism.

12. Hur gör man en egen modul?
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Skapa gemensam labbkatalog

Sammanfattning

I denna introduktion beskrivs hur du och din labbkompis ordnar en gemensam
labbkatalog.

Inloggning

Du och din labbkompis har varsitt konto (användarnamn och tillhörande lö-
senord). Välj ett av kontona och logga in.

Filhanteraren Windows Explorer

Med Windows Explorer kan du utforska datorns och nätverkets kataloger . En
katalogs innehåll kan bestå av andra kataloger och filer . Kataloger som ligger
i en annan katalog kallas ibland underkataloger .

Kataloger med underkataloger bildar en grenliknande struktur där varje
gren är en katalog. Denna grenstruktur kallar man ofta katalogträd . Till skillnad
från verkliga träd brukar man dock låta katalogträd breda ut sig nedåt och till
höger istället för rakt upp. En bieffekt av detta är att katalogträdets rot hamnar
längst upp till vänster samt att man pratar om att ”gå ned” i en katalog (eller
underkatalog).

På en PC finns också något som kallas enhetsbeteckningar . Dessa betecknar
välanvända enheter så som delar av en speciell hårddisk (både på den aktuella
datorn och på en större s k ”server”-dator), CD-läsare eller diskettstation. En-
hetsbeteckningarna består av en bokstav följt av ett kolon, t ex ”C:” eller ”H:”.
En finess med enhetsbeteckningar är att man kan knyta en enhetsbeteckning
till en speciell katalog så att den blir enklare att hitta.

En fullständig beskrivning av den plats en fil ligger på brukar kallas sökväg
och kan till exempel se ut på följande sätt:

H:\prg\labbar\introlabb\Test.py
L:\introlabb\Test.py

Notera att enhetsbeteckningar, katalognamn och filnamn separeras av ett ’\’.

Starta Windows Explorer och titta runt

Starta Windows Explorer (Start → Windows Explorer). Windows Explorer
är indelad i två halvor. Den vänstra halvan visar katalogträdet med aktuell
katalog markerad. Den högra halvan visar innehållet i den aktuella katalogen.

Klicka dig runt lite och se vad som finns. Välj enhetsbeteckningen H: och
se vad som finns där. Denna katalog är hemkatalogen för den inloggade.

Titta också under G: som är katalogträdet för de distribuerade kataloger-
na i nätverket. Här kan man hitta de flesta hemkataloger, inklusive din egen.
Leta reda på hemkatalogerna till båda i labbgruppen. Notera att de filer som
eventuellt syns inte automatiskt är läsbara för alla. Det beror helt och hållet
på vilka rättigheter som är inställda för filen (och katalogen som filen ligger i).

Ett klick på höger musknapp ger ofta en meny med ytterligare möjligheter.
Detta kan utnyttjas om man till exempel vill skapa en underkatalog eller ändra
rättigheter på en katalog eller fil.
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Ordna labbkataloger

Du ska nu skapa och sätta passande katalogrättigheter på de kataloger som du
kommer använda under kursen. Läs noga beskrivningen som följer, och hoppa
inte över något steg! Tips! Om en av er läser och den andra sköter tangentbord
och mus, så går det lättare!

Visa med Windows Explorer innehållet i den inloggades hemkatalog (via
H:). Skapa en katalog med namnet prg (som är en förkortning av ”program-
meringsteknik”). Gå ned i denna katalog och skapa en katalog med namnet
labbar.

Katalogen labbar kommer bli en gemensam labbkatalog. Notera att den än
så länge bara är tillgänglig via den inloggade personens konto.

Ändra katalogrättigheter

Ändra rättigheterna för katalogen labbar genom att markera den och välja hö-
gerklick → Properties. Välj fliken ”Security”. Tryck på ”Add” för att lägga
till en person till åtkomstlistan. Notera att ett fönster med två delar dyker upp.
Den övre delen innehåller en lista på alla användarkonton du kan lägga till. Då
listan är jättelång bör du undvika att hoppa runt i den. I den nedre delen av
fönstret kan du skriva in delar av ett användarkonto och få upp förslag. Ersätt
all text i det nedre fönstret med labbkompisens kontonamn och klicka på ”Check
Names”. Notera hur det fullständiga kontonamnet dyker upp. Klicka på ”Ok” för
att lägga till personen i åtkomstlistan.

Nu finns labbkompisens användarkonto med på åtkomstlistan för katalogen,
men vilka rättigheter den användaren har är fortfarande inte ändrat. Markera
alltså användarkontot för labbkompisen och kryssa i alla ”Allow”-rättigheter
utom ”Full Control” och klicka på ”Ok”. Nu ska både den inloggade och den
nytillagda i gruppen ha tillgång till labbkatalogen.

Knyt enhetsbeteckning till labbkatalogen

För att förenkla hanteringen av era labbfiler ska bägge i labbgruppen knyta en
enhetsbeteckning (L:) till den gemensamma katalogen labbar. Det är då viktigt
att komma ihåg vilken användare som skapade och ändrade rättigheterna för
katalogen. Vem av er har den gemensamma katalogen?

Nedanstående ska genomföras av varje labbgruppsmedlem som ska ha till-
gång till den gemensamma katalogen.

Du som vill fixa din L: loggar först in och startar Notepad (i Programme-
nyn). Skriv in raden

net use L: \\mimer.kth.se\dfsr\s\s06\användarnamn\prg\labbar /p:no

men ersätt “användarnamn” med ditt eget användarnamn. (Det ska vara sam-
ma användarnamn hos bägge, nämligen användarnamnet på den som äger den
gemensamma katalogen.)

Spara filen under namnet startup.bat Nu kan du se att du har filen
startup.bat i din hemkatalog.

Spara och stäng filen. Öppna Windows Explorer och leta rätt på filen du
just ändrade (H:/startup.bat). Dra nu denna fil till Start → Programs →
Startup → ... där du släpper den. Kontrollera att Start → Programs →
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Startup → Shortcut to startup.bat existerar. Om inte, så måste du dra
dit filen igen.

Logga nu ut och sedan in igen för att med Windows Explorer kontrollera
att du har en enhetsbeteckning L:. Har du inte det är det dags att kontrollera
anvisningarna igen.

Har vi gjort allt?

En av oss (nämligen den med användarnamnet ..............................) har
en katalog H:\prg\labbar som båda i gruppen har rätt att använda.

Vi har knutit enhetsbeteckningen L: till ovanstående katalog.

Vi har skapat filen startup.bat, lagt in användarnamnet ovan samt skapat
en genväg (shortcut) från startmenyn.

Vi har gjort detsamma på den andres katalog!


